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Chapter 1 - Introduction

This chapter describes installation and lists the main features of the QT-1
Software. It also explains the execution model and the three operating levels of
the software.

Installation
The following section tells you how to install the Software on the Windows
platform.

The QT-1 Software comes in compressed form on floppy disk. Installing it
requires approximately 5 MB of space on your hard drive.

The QT-1 Software is used with a National Instruments GPIB Interface. The
Interface and the 488.2M Software Driver must be installed prior to use.

Windows 95/98/ME & Win2000/NT

Insert the CDROM into CD reader or disk one of the QuickTest Software into
the 3.5-inch disk drive and run the setup . exe program using one of the
following methods:

Using the CD reader, the set up program should start automatically when the
tray is recessed.

Under Windows 9X or NT, launch the Windows Explorer. Click on the icon
of the drive that contains the installation disk. Find setup.exe in the list of
files on that disk and double-click on it to begin installation.

Under Windows 9X, choose Run... from the Start pop-up menu. In the
dialog box that appears, type X : \ setup (where X is the name of the drive that
contains the installation disk). Click on OK to begin installation.

After you begin installation, follow the instructions that appear on the screen. If
the program has previously been installed the installation program will run the
un-install program first.

Product Overview
The QuickTest Software creates an automated test system. This toolkit
includes a complete Test Executive that can perform many standard test
operations.
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Chapter 1 Introduction

The Test Executive runs test programs using pre-programmed C functions and
implements the following features:

e Test sequencing based on pass/fail status, preconditions, and goto
commands

e Logging of test results to ASCII file or database

¢ Run-time interfacing, including prompts for operator and Unit Under Test
(UUT) serial number, Pass, and Fail banners, and run-time error notification

¢ Halting and looping on individual test failure

e Testing continuously in UUT mode

e Three operating levels (operator, technician, developer)

Execution Model
The Test Executive can execute a sequence in one of three ways — UUT Test,
Single Pass, or Single Test. The UUT Test, invoked when the operator clicks
on the Test UUT button, executes a test sequence repetitively. Each test cycle
includes a UUT serial number prompt and Pass, Fail, and Abort banners to
notify the operator of the test result for the current UUT. UUT Test mode is the
production-operating mode for testing multiple UUTs.

You use Single Pass mode sometimes for diagnostic purposes. In Single Pass
mode, the test sequence executes only once, and the Test Executive does not
prompt you for the UUT serial number or with the Pass, Fail, and Abort banner
display. The following illustration shows the overall flow of execution in UUT
Test and Single Pass operation.
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Chapter 1 Introduction

e

UUT Info

= [

- Skip if in
iy s Single Pass mode
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e——
e O Lot
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Figure 1-1. Flowchart for UUT Test and Single Pass Operation

In Addition to UUT Test and Single Pass operation, you can choose Single Test
mode to run an individual test. You should use Single Test mode primarily for
diagnostic purposes.

Operating Levels
The Test Executive has three operating levels (Operator, Technician, and
Developer). The following table summarizes the capabilities of each operating
level.

Table 1-1. Test Executive Operating Levels

Level UUT Test Debug Sequences/Tests Edit Sequences
Developer Yes Yes Yes
Technician Yes Yes No
Operator Yes Yes No
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Chapter 1

Introduction

At the Developer level, you can access all capabilities of the Test Executive.

At the Technician level you can execute tests to diagnose a UUT. You can run
individual sequences and test, but you cannot edit sequences.

At the Operator level you only can execute test sequences in UUT Test mode
by clicking on the Test UUT button.

You set the operating level in the Login dialog box, which you access through
the File menu. You can change the operator level at any time while the Test
Executive is running. The operator level and default passwords appear in Table
1-2.

Table 1-2. Default Login Names and Passwords

Operator Level Password
Developer Developer
Technician Technician

Operator Operator
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Chapter 2 - Getting Started

This chapter introduces the basic concepts of test executive operation and test
sequence development, using the examples described in the following table.

Table 2-1. Examples for Operation of a Test Executive

Example Relevant to Users Who...
Operating a test sequence Operate the Test Executive
Editing the test sequence Create test sequences

Operating a Test Sequence

Starting the Test Executive

Perform the following steps to start the Test Executive.
l. Launch the Test Executive.

2. Enter your name and password as shown in Figure 2-1. The password
you provide determines the operating level of the Test Executive. For this
example you work at the Operator level, so type operator in the Login Name
and Password fields.

w1 CY1 Test Executive Login

Pazzward:
Cancel

Figure 2-1. Login Dialog Box

Note: You can access the Operator level by typing any text in the Password
field. However, you must type technician to access the Technician
level and developer to access the Developer level.

5. Click on OK to confirm you entries.
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Chapter 2  Getting Started

On the Test Executive front panel, notice the word Stopped that appears next
to the large LED. This LED indicates status and the word Stopped indicates
that no test sequence is currently running. Figure 2-2 shows the Test Executive

front panel.
5] LabWindows/C¥I Test Executive _ [ 3]
File Report Sequence Hun Debug Ophonz Help
Sequence Descriptiu:un:| Sequence File: Login Level: 187510
Mo Description | Mo Sequence | O perator | 04-08-1938 ‘
—

4 o

Mumber of Tests
0

' Stopped

Current Test
7 tiop on Pabag Lhene Taor tiams u

Figure 2-2. Test Executive Front Panel in Stopped Mode

Running a Test Sequence

Perform the following steps to run a test sequence.

[ -]

1. Select Open... from the File menu of Test Executive front panel.

2. Select the file demo . squ  from the Vitrek directory.

When you load demo . squ notice that the steps of the test sequence appear in
the Sequence Display. The name of the test sequence appears in the Sequence
File indicator.

3. Click on the Test UUT button located beneath the Sequence Display

to execute the sequence. The Test Executive prompts you for the serial number
of the UUT.
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Chapter 2  Getting Started

4. Type 123 in the input box and click on the OK button. The sequence
executes.
As the sequence executes, notice the following events on your screen.

The Status indicator displays the work Running and the LED flashes.

As each test runs, the word Running appears next to the name of the active test
in the Sequence Display.

After each test runs, the Pass, Fail, or Skip status of the test appears next to the
name of the test in the Sequence Display, and the test result appears in the Test
Display.

When the sequence execution completes, a banner appears indicating whether
the UUT passed or failed, or whether the user aborted the sequence.

Click on OK in the completion banner, and enter another serial number when
the UUT Information dialog box appears. The Test Executive continues to
prompt you for another UUT serial number until you click on Stop in the UUT
Information dialog box.

To view the test report after execution completes, choose View from the
Report menu.

The test Report includes the name and description of the sequence, the date and
time that testing began, the operator’s name, and the results of testing for each
UUT. When you set this test sequence to generate a test report file, the system
automatically writes the test report to the file each time the sequence executes.

Changing to Technician Level
Perform the following steps to change from Operator to Technician level and to
see the more flexible execution capabilities at the Technician level.
Select Login... from the File menu.
In the login dialog box, type the word technician in the Password field and
click on OK. The Single Pass, Run Tests, and Loop on Tests button

appear in the lower left corner of the Test Executive front panel.

If you do not see these buttons, select Login... from the File menu again and
carefully type the word technician in the Password field again.
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Chapter 2  Getting Started

How to Run Single Tests and Use Single Pass Mode
To run a single test, click on the name of the desired test and then the Run
Tests button. Notice that only the selected test runs. Single Test execution
runs a subset of tests that that you select for diagnosis and troubleshooting. The
test status appears next to the test name in the Sequence Display. You can also
execute a test repeatedly by clicking on the Loop on Tests button. You can
also use Run Tests to run multiple tests in the sequence. Place a checkmark
beside the tests you want to run and click on Run Tests.

Now click on the Single Pass button. Clicking on this button runs the entire
test sequence one time without the UUT prompts and banners. Notice that the
sequence stops after it executes one time. When you select View from the
Report menu, the Test Executive displays the updated Test Report.

Exiting the Test Executive
Select Exit from the File menu to dismiss the front panel of the Test Executive.

Creating and Editing a Test Sequence
The following steps show you how to set up and edit a test sequence.
Launch the Test Executive.

Enter developer in the Password field of the Login dialog box that appears and
click on OK.

Click on the New menu item from the File menu to create a new empty
sequence.

Select Edit Sequence... from the Sequence menu to invoke the Sequence
Editor. Notice that the list box at the top of the Sequence Editor dialog box is
empty. This list box will show all the tests that you define for a test sequence.
You use the Sequence Editor to input all of the specifications that define a test
sequence.

Click on New Test. The test attributes controls appear below the test list box,
as shown in Figure 2-3.

There are two types of test functions in the Vitrek QuickTest package. The first
is an edit type and the second is an executable type. The Input Buffer is actually
the file name of the parameters file the edit file saves and the executable uses.
Once the edit function is executed, the parameters configuration file is written
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Chapter 2  Getting Started

and can be used repeatedly by the executable version of the test function. The
developer can execute the edit functions and specify the parameters one time
and the user can run the executable sequences without changing parameters. In
the example below the edit version of the 9441 Configuration Command
“CNFG” is shown. The edit version of the function starts with ‘E’ in
gpib_tests.obj. A complete list of the functions and their explanations is
available in the QUICKTEST FUNCTIONS document located on the
distribution CDROM disk. In the example below the sequence file is loaded
from the example sequence provided. The file name is V4 UTIL.squ and the
login level is developer.

=101 ]

£ LabWindows/CYI Test Executive k

File Report Sequence Run Debug Database Oipkions  Help

Sequence Description: Sequence File:| Login Lewvel] 11:28:38
12-11-2002

I |V4_LITIL.squ IDeveIoper

Seguence Display:| :
B7 CHEG Ro232 =l
¥ OREN Ro237
EV ¥4 _UTIL

¥ V4 UTIL

¥ _CLOSE RS232

Mumber of Tests

TestUUT | . Bun Tests I & S d
_ . Stopped F
Single Pasz | i Loopon Tests 28 :
Curnrent Test
|_ Stop on Failure Clear Test Statuz i |1

Figure 2-3. Test Sequence Panel

This test is a V4 test that uses RS-232 and configures the utility options for the
V4. The sequences configure the port, open it, edit the utility parameters,
executed the utility function, and close the port. The functions that begin with ‘E’
are edit functions and require user interaction, but only in developer mode
(Login Level above). Under the Sequence pull down menu select Edit
Sequence and the following panel is displayed.
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(=] Test Executive Sequence Editor |

El=  Edit

Test File . Function | Lt Rezult Comp.

EV_CNFG_RS gpib_tests.ob® EV_CNFG RS232 {EOOL} = L

¥ OPEN R3Z gpib tests.cb ¥ OPEN R3232 {BOOL}

EV V4 UTIL gpib tests.ch EV ¥4 UTIL {BOOL} Copy I
¥ ¥4 UTIL gpib_tests.oh V_¥4 UTIL {BOOL}

¥ _CLOSE RS gpib tests.cb ¥ _CLOSE R3232 {E00L} Paste i

Inzert Pogition

 Above
Below

Mew Test |
Test Mame: Furction M arme: "
Dezcription...
|Ev wa uTIL |Ev wa UTIL Mi_l
File: tarne: Preconditions. . Mew Goto |
lc:Witrek\gpib_tests.u:ubi Select File... |
Fun Options. ..

Edit Paths... i

Limit S pecification;

|[BOOL} Set Limits... | Setup/Cleanup...

Database... |
|nput Buffer:
I Advanced. .
Sequence Sttrbutes oK
Load Mode — =
'gF're-Iu:uad Tists D escription... Setup/Cleanup... Report... I EgE |

Figure 2-4. Test Attributes Child Panel

Highlight the subsequence named EV_V4 UTIL. In the control labeled Test
Name a name is given. This can be any name and is what is displayed in the
main executive window.

In this example, the ‘C’ function is EV_V4 UTIL(void) and is specified under
the Function Name control. The file name where the function resides is always
gpib_tests.obj and must be located in the CA\Vitrek directory on the local
machine.

If the Input Buffer control is left blank, the edit function creates a configuration

file called DEFAULT.CFE and the executable, provided the Input Buffer is
blank will use this parameters file.
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The next function in series is the executable version and it is shown below with

its appropriate ‘C’ function, V_V4 UTIL();.

i
File Edit h

Test File Function L‘@ |t Reszult Comp.

EV_CNFG RS gpib_tests.ob EV_CNFG_RS232 {BOOL} a Cut

¥ OPEN RS2 gpib_tests.ob V_OPEN RS232 [BOOL}

EV V4 UTIL gpib tests.ob EV ¥4 UTIL {BOOL} Copy I

gpib tests.oh {EO0L}
¥_CLOSE_RS gpib_tests.ob V_CLOSE _R3232 {BOOL} ﬂl
Inzert Position
| Above
__I Below
Mew Texst |
Test Mame: Function Mame: _
Description. ..
[V_va o fv_vauTi _ MenSubseq_|
File Marie: Freconditions. .. Mew Gota |
ic:Witrek'\gpib_tests.abi Select File... |
Fun Options...

Limnit 5 pecification:

Edit Paths... I

[ et Limits.._| Setup/Cleanup. . Database.. |
|nput Buffer:
I Advanced. .
Sequence Aftributes oK
Load Mode - —
gF're-Ioad Tasts Description... Setup/Cleanup... Repart... I e |

Figure 2-5. Test Sequence Panel

When this example sequence executes (press Test UUT) , the following pop up
window appears as a result of executing the EV_V4 UTIL function. Notice the

Configuration File name is DEFAULT.CFE.

¥4 Utility Configuration®’

A Current

GFIB Address
|2 mamps ga_’
Arc Mode AL Freguency
[Enable & Continue  _| BOHz [ 1] B0H=

Canfig File Path/Mame

=101 x|

Test Mode
IFru:um Present Step |

IR Test Mode

|

ITimer

Beset Parms to Default | |C:\WITREKADEFAULT.CFE

. SavePams and Exit |

Figure 2-6. Edit Test Sequence Panel with Default file name
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No user interaction is required to run the executable version.
If the Input Buffer control specification was UTILCNFG the window would
appear as below.

] ¥4 Utility Configuration -10] x|
bl GPIE Address Test Mode
.:a_ 2 mAmps gB IFru:-m Present Step |
& Mode AL Frequency IR Test Mode
|Enable & Continue __| 50Hz [T [ ] 60Hz [ Timer [ |

Config File Path/Mame
Fezet Parms to Default | 1|:;W|THEKMT||_ENFG_EFE Save Parmz and E =it

R

Figure 2-7. Edit Test Sequence Panel with Input Buffer File name

Note that the filename must be in DOS filename type format, 8 characters, no
spaces, underscores are legal. The extension is always provided by the function.
The pathname defaults to CA\Vitrek but may be changed to accommodate
network storage of the configuration files using QTPATH.TXT.

Locations of Test Sequences and Configuration Files

Test Sequence files can be stored on a network so many production type
computer stations can access and execute the same test files. Configuration files
are the parameter files created by the edit test. These read only files can also be
store on any network path by editing the QTPATH.TXT file. This file must be in
the CAVITREK\ local directory and is written in the following format.

1, \NETWORKSEVER1\SOMEDIR\SOMESUB)\;

The first character can be a 1 or 0 (zero). This is the USE PATH field and if it is
a 1 the path is used to find the configuration files. A zero indicates the
configuration files are located in the CAVITREK\ directory. The pathname must
end with a semi-colon to be valid.

Configuration files have the extensions:

V944CNFG " CF1"™
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V944LOOHM " CF2"
V944LOOHM930  {".CF3"}
V944VAC {".C10"}
V944VDC "CI1"}
V944MEGOHM  {".CF4"}
V944 RSLT {".CF5"}
V948MUX {".CF8"}
V948POL {".CF9"}
V4 ACW (" CFA"}
V4 IRS (" CFB"}
V4 GBON (" CFC"}
V4 DCW {"CFD"}
V4 UTIL {".CFE"}
RS232 (" CFF"}

Passing or Failing the Sequence

You must give the Test Executive a limit specification that defines whether a test
passes or fails. The Test Executive refers to the test structure of the test
function and applies the limit you specify in the Sequence Editor to each test.
The test structure contains both a Boolean flag and a numeric measurement.

Click on the Set Limits... button to view the Set Limits for Test dialog box.
Scroll through the comparison Type ring control to see the available types of
checking. If you choose a numeric comparison, you must also enter the numeric
limits for the comparison, you must also enter the numeric limits for the
comparison. For this example, set Comparison Type to BOOL. Your Set
Limit Specification dialog box should match the settings in Set Limit
Specification dialog box should match the settings in Figure 2-4.

Note: All tests in the QT944 Software use the Comparison Type of BOOL.
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] Set Limits for Test

Comparizon type:

£ BOOL

Mo comparizon done by Test Executive - Test
zets statuz flag to indicate PASS/FAIL state.

[+ Test fall causes sequence fail

Ok Cancel

Figure 2-8. Set Limits for Test Dialog Box

When you set Comparison Type to BOOL the Test Executive uses the result
flag in the test structure to determine whether the test passed or failed.

Click on OK. The Limit Specification control now contains the text (BOOL).

Your completed test sequence should match the Sequence Editor list box
shown in Figure 2-5.
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& Test Executive Sequence Editor ﬂ
Fil=  Edit
Test File [+, Function Input Rezult Camp.
EV_CHFG RS gpib_tests.of? EV_CNFG RS232 {EOOL} ] L
¥ OPEN E32 gpib tests.oh ¥ OPEN R3232 {EOOLY
EV V4 UTIL gpib ;.ob EV ¥4 UTIL {BOOLY Copy I
V_¥4 UTIL gpib_tests.ob ¥_¥4 UTIL {EOOL}Y
¥V _CLOSE RS gpib tests.ob ¥_CLOSE R3z3z {EO0LY Paste i
Inzert Pogition
| Above
_J Below
Mew Test |
Test Mame: Furiction M ame: "
D ezcription...
|Ev v _UTIL [Ev wa_UTIL Mew Subseq
File N arne: Preconditions. ..

Mew Goto |

ic: Wfitrel hapib_tests obj

Limit 5 pecification:

Fun Options. .

Edit Paths... i

|
|
Select File... | |
|
|

[E0oL; Set Limits.. | Setup{Cleanup. Database... |
Input Buffer:
I Advanced. .
Sequence Attributes oK
Load Mode — =
'gF're-Iu:uad Tasts Description... Setup/Cleanup.,. Repart... I = |

Figure 2-9. A Completed Test Sequence Setup

Before you save your new test sequence, you may need to set preconditions
and related attributes, as described in the following sections. Remember that
you can edit any test in the Sequence Editor by clicking on the test you want to
modify in the Sequence Editor list box. The specifications of the test appear in
the Test Executive Attributes controls located below the list box. As you make
changes in the controls, the list box displays you modifications.

Note: To enter attributes for a new test you must click on the New Test
button.

Setting Preconditions

In the following steps you set up a dependency between the two tests in the
sequence you created in the previous section. This is an optional process and
depends upon how you structure your test sequences.

Click on the Test Preconditions button. The Precondition Editor window
appears.
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5] Test Executive Precondition Editor

Tests: Ereconditions: Insert Pasitian:
944 Configure Al .f‘.i Below | | | Above
De Dielectric
Add Condition... i
Add Al Of 1
&dd Any OFf i
244 Y |

[Delete Condition |

Clear Conditons |

Figure 2-10. Precondition Editor

Click on Random-Numeric in the Tests list box. Then clock on Add
Condition. ..

In the Add Condition dialog box that appears, set up the following dependency
for Vdc: that Cnfg must pass before Vdc can execute:

Set the Type switch to PASS and click on 944 Configure in the Tests list box.
A checkmark appears beside the test name. Your setting should match those in
Figure 2-7.

(5] Add Condition

Tests:

.......... 944 Confiog «

Type:

PaSS [TI FAIL

Figure 2-11. Using Add Condition to Set Preconditions
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Click on OK.

The Preconditions list box now shows PASS 944 Configure. This signifies that
Vdc runs only if the precondition test 944 Configure passes.

Note: The Preconditions list box displays only the preconditions for the test
you have selected in the Tests list box.

Your Precondition Editor dialog box should look similar to the one in Figure 2-
8. Click on OK to save the new dependency specification and return to the
Sequence Editor.

& Test Executive Sequence Editor ﬂ
File Edit

Test File +. Function Input Reszult Comp.

EV CHFG RS gpib tests.off EV CNFG RSZ32 {EO0L} ] Cut

¥ OPEN RE3Z gpib tests.ob ¥ OPEN R35:232 IBOOL}

i E¥Y V4 UTIL gpib tests.ob EV V4 UTIL JEOOL} —ICDDE

¥ ¥4 UTIL gpib tests.ob ¥ V4 UTIL {EOOL}
¥_CLOSE_RS gpib_tests.ob ¥_CLOSE_RS232 {EOOL } Paste I
Inzert Position

| Above
Below

Mew Test |
Test Mame: Function Mame: _
D ezcription...
|Ev_wd_UTIL [Ev wa_UTIL M
File Mame: Freconditions. ..

Limit 5 pecifization:

|eooL Set Limits... I Setup/Cleanup...

Fun Options... Edit Paths. I

|

| MHew Goto |
ic: Wfitrek hgpib_tests obj Select File... | |

|

|

Databasze... |
Input Buffer;
l Advanced. .
Sequence Attributes oK
Load Mode — =
gF‘re-Inad Tists [rescription. .. Setup/Cleanup... Report... I i |

Figure 2-12. A Completed Random-Boolean Setup

Setting the Report File

You can configure the Test Executive to report test results by specifying a
report file to receive those results. The following steps tell you how to specify
the default report file.

Click on the Report... button in the Sequence Attributes section. The Set
Default Report File dialog box appears.
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Use the Select File button to select vdc . rpt as the default report file.

Click in the Lock File Name box. Checking this box locks the filename to the
value in the Test Executive Report File control. If you do not lock the file name,
the system gives you the opportunity to change the filename each time you open
the sequence file.

(2] Set Default Report File

Test Report File:
C:Witrek Al Dielectric Strength.rpt : Select File... 1
Repart File Mode:
E Append I¥" Lock File Mame

Oenurite

Figure 2-13. Specifying the Default Report File
Click on the OK button to return to the Sequence Editor.

Click on OK in the Sequence Editor to return to the Test Executive front panel.
Click on No when the program prompts you to save your sequence.

You are now ready to run your test sequence.

Running the Sequence

To run your test sequence, perform the following steps:
Run your new test sequence. The Test Executive will automatically determine
whether the test passes or fails based on the values transmitted in the test

structure. Perform the following steps to see your specification in action.

Click on Test Executive UUT, enter a serial number of your choice, and click
on OK.

Perform tests for several UUT serial numbers and then click on the Stop button
in the UUT Information dialog box.

Select View from the Report menu to see the data that the Vdc function
generated from each test.
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Choose Exit from the File menu to exit from the Test Executive. The
application prompts you to save the sequence you created. To maintain this
example in its original state, do not save you changes.

The examples presented up to this point in the chapter show the fundamental
operations in the Test Executive and also developer-level operations: creating
test functions and using the Sequence Editor to develop test sequences that use
these functions.

Example Sequences

The QT944 package includes several test sequence examples located in the
C:\Vitrek\Examples directory.
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Chapter 3 - Operating the Test Executive

This chapter describes the Test Executive main panel -- the controls, indicators,
and operator dialog boxes. The main panel is the user interface for run-time
operation.

[ LabWindows /CYI Test Executive =101 =l

File Report Sequence Run Cebug Database Ophions  Help

Sequence Description: Sequence File:| Login Level:| 112838
|'| 2-11-2002

I |\r"4_LITIL.$qu IDeveInper

Seguence Display|
BV CHEG Ro232 a |
¥ OLEN RS537
EV V4 UTIL

¥ V4 UTIL
¥_CLOSE RS232

Test UUT | © RunTests | w? Mumber of Tests
81 £ n
_ .~ Stopped F———
Single Pass | i Loopon Tests = :
Current Test
I_ Stop on Failure Clear Test Statuz | |1

Figure 3-1. Test Executive Main Panel

Features of the Main Panel

The menu items, buttons, and other controls on the Test Executive main panel
access the following three areas of operation.

e Sequence file operations and login
e Execution

e Display

The following sections describe the Test Executive controls.
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File Menu

Login...

Choose the Login... menu item from the File menu to enter a new user name
and password. You can access the Login... menu item at any operating level.

New
The New menu item creates a new, empty sequence. You can use the New
menu item only at the Developer operating level.

Open...
The Open... menu item opens an existing sequence file. You can use the
Open... menu item at any operating level.

Close
The Close menu item closes an open sequence file. You can use the Close
menu item at any operating level.

Save
The Save menu item saves the current test sequence. You can use the Save
menu item only at the Developer operating level.

Save Copy As...
The Save Copy As... menu item saves a test sequence to file. A dialog box
appears, prompting you to name the file. You can use the Save Copy As...
menu item only at the Developer operating level.

Print...
The Print... menu displays a dialog box where you select a report file to print.
You can use the Print menu item at any operating level.

Exit

The Exit menu item causes the Test Executive to stop execution. If you have
modified any of the currently loaded sequences, the Test Executive prompts you
to save your changes before quitting. You can use the Exit menu item at any
operating level.

Report Menu

View

The View menu item displays the current test report. You can view the report
with the built-in viewer or an external program such as Notepad. (The Options

3-2



Chapter 3 Operating the Test Executive

Menu section in this chapter describes your options for viewing reports). You
can use the View menu item at any operating level.

The Test Executive Report contains the testing results for the execution of a test
sequence. The following segment of monospaced text shows the format of a
Test Report.

ADD TEST REPORT EXAMPLE!

Delete
The Delete menu invokes a dialog box where you can remove from disk the
test report (. rpt) file for the test sequence (. squ) file that is open on the
Test Executive front panel. You can access the Delete menu item at any
operating level.

Screen and File
The Screen and File menu items control which tests results display on screen
or appear in the report file. You can choose to display or save all results, only
pass results, only fail results, or no results. You can use the Screen or File
menu items at any operating level.

Sequence Menu

Edit Sequence...
The Edit Sequence... menu item invokes the Sequence Editor. You can use
the Edit Sequence... menu item only at the Developer operating level.

View Description...
The View Description... menu item invokes a dialog box that displays the
entire sequence description. You can access the View Description... menu
item at any operating level.

Generate Documentation...
The Generate Documentation... menu item generates a file that documents
the settings for each test in the current sequence. You can use the Generate
Documentation... menu item at any operating level.

Sequence Names
The names of all loaded sequences also appear in the Sequence menu. You
can select a sequence name to make that sequence the active sequence in the
Test Executive front panel.
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Run Menu

Test UUT

Single Pass

Run Tests

The Test UUT menu item starts a repetitive execution of the test sequence from
UUT testing. (See the Execution Model section in Chapter 1, Introduction, for
information about the Test Executive UUT mode of execution.) You can use
the Test UUT menu item at any operating level.

The Single Pass menu item executes the test sequence on time. (See the
Execution Model section in Chapter 1, Introduction, for information about the
Single Pass mode of execution.) You can use the Single Pass menu item only
at the Developer and Technician and operating level.

The Run Tests menu item executes the tests you select in the Sequence
Display. You can select multiple tests by placing a checkmark beside each test.
The Run Tests menu item is available only at the Developer and Technician
operating levels.

Loop on Tests

The Loop on Tests menu item starts a repetitive execution of the tests currently
selected in the Sequence Display list box. You can only access the Loop on
Tests menu item from the Developer and Technician levels.

When you select Loop on Tests, the dialog box shown in Figure 3-2 appears.

5 Loop Test I

[ Stopif test FAILs

] i Cancel

Figure 3-2. Loop Test Dialog Box

Your loop test can execute a specific number of iterations, with the option to
stop if the test fails. To specify the number of iterations, enter the number of
iterations in the Loop count control. The preceding figure shows a loop test that
will iterate five times. If you want looping to stop when the test fails, click on
the Stop if test Fails check box.

3-4



Chapter 3 Operating the Test Executive

Sequence Pre Test
The Sequence Pre Test menu item forces execution of the setup test for a
sequence. The cleanup test for a sequence normally executes automatically
before the sequence executes.

Sequence Post Test
The Sequence Post Test menu item forces execution of the cleanup test for a
sequence. The cleanup test for a sequence normally executes automatically
after the sequence executes.

Sequence Load Test
The Sequence Load Test menu item forces execution of the load test for a
sequence. The load test for a sequence normally executes automatically when a
sequence loads.

Sequence Unload Test
The Sequence Unload Test menu item forces execution of the unload test for
a sequence. The unload test for a sequence normally executes automatically
when a sequence unloads.

Debug Menu

Note: The Debug menu also appears as a pop-up menu when you right-click
on a test in the Sequence Display listbox.

Toggle Breakpoint
The Toggle Breakpoint menu item sets or clears a breakpoint on the currently
selected test in the Sequence Display. You can use the Toggle Breakpoint
menu item only at the Developer or Technician operating level. You use the
other commands in the Debug menu to move beyond the breakpoints you set
using Toggle Breakpoint.

Break at First Test
The Break at First Test menu causes the Test Executive to break execution at
the first test. You can use the Break at First Te st menu item at any operating
level.

Pause

The Pause menu item stops sequence execution and enters breakpoint mode.
You can use the Pause menu item at any operating level.
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Continue

Step Over

Step Into

The Continue menu item ends breakpoint mode and resumes execution.
You can use the Continue menu item at any operating level.

The Step Over menu item executes the current test in the sequence. Execution
stops before the next test in the current sequence. You can use the Step Over
menu item only at the Developer or Technician operating level.

The Step Into menu item executes the current test in the current sequence. If
the test is a subsequence, execution stops before the first test in the
subsequence. Otherwise, execution stops before the next test in the current
sequence. You can use the Step Into menu item only at the Developer or
Technician operating level.

Set Next Test to Cursor

Set Next Test to Cursor sets the currently selected test in the Sequence
Display as the next test to execute. You can use Set Next Test to Cursor to
skip tests during debugging. The Set Next Test to Cursor menu item is
available only at the Developer or Technician operating level.

Finish Sequence

The Finish Sequence menu item executes the remaining tests in the current
sequence and reenters breakpoint mode before the next test in the parent
sequence. You can use the Finish Sequence menu item only at the Developer
or Technician operating level.

Terminate Execution

Normal

The Terminate Execution menu item exits breakpoint mode and terminates
sequence execution without executing more tests. This command is equivalent
to Abort. You can use the Terminate Execution menu item only at the
Developer or Technician operating level.

The Normal menu item sets the run mode of the selected test to normal, instead
of Force to Pass, Force to Fail, or Force to Skip. You can use the Normal
menu item only at the Developer or Technician operating level.

Force to Pass

The Force to Pass menu item sets the run mode of the selected test to Force
to Pass. You can use the Force to Pass menu item only at the Developer or
Technician operating level.
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Force to Fail
The Force to Fail menu item sets the run mode of the selected test to Force to
Fail. You can access the Force to Fail menu item only at the Developer or
Technician operating level.

Skip
The Skip menu item sets the run mode of the selected test to Skip. You can
use the Skip menu item only in the Developer or Technician operating level.

Note: Changing the run mode using the menu items Normal, Force to Pass,
force to Fail and Skip is equivalent to using the Sequence Editor. If you
use these menu items at the Developer level, the Test Executive prompts
you to save the sequence before it is unloaded.

Database Menu

View Database...
The View Database... menu item invokes the Database Results Viewer. In
the results viewer, you can see an overview of the sequence and test results.
The results viewer also displays the details of any sequence or test results. You
can access the View Database... menu item at any operating level.

Delete Database
The Delete Database menu item deletes the sequence and test result tables for
the current sequence. You can access the Delete Database menu item only at
the developer operating level.

Logging Enabled
The Logging Enabled menu item activates logging to database tables. You
can change Logging Enabled only at the developer and technician operating
levels.

Options Menu

Report...
The Report... menu item invokes the Report options dialog box. In the Report
Options dialog box you can choose between viewing reports in the Test Display
Box, the built-in report viewer or an external report viewer. You can access
the Report... menu item at any operating level.
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Controls of the Front Panel

Test UUT

The Test UUT button starts a repetitive execution of the test sequence for
UUT testing. (See the Execution Model section in Chapter 1, Introduction,
for information about the Test UUT mode of execution.) You can use the Test
UUT button at any operating level.

Single Pass

Abort

The Single Pass button executes the test sequence on time. (See the
Execution Model section in Chapterl, Introduction, for information about the
Single Pass mode of execution.) You can use the Single Pass button only at
the Developer and Technician operating levels.

The Abort button stops execution of the test sequence after the current test
completes execution. When you have clicked on Test UUT to start testing,
clicking on Abort stops testing for the current UUT after the current executing
test completes. The system then prompts you for the next UUT serial number.
The Abort button is available at all operating levels, but is active only while a
test is running.

Abort Loop

Clicking on the Abort Loop button stops the execution of a loop that is defined
for a single test. (You define a loop for a single test in the Run Options dialog
box of the Sequence Editor.) Test sequence execution then continues with the
next test. You can use the Abort Loop button only when the Test Executive
loops on a test. You can use the Abort Loop button at any operating level.

Run Tests

The Run Tests button executes the tests that you select in the Sequence
Display. You can select multiple tests for execution by placing a checkmark
beside each test. The Run Tests button is available only at the Developer and
Technician operating levels.

Loop on Tests

The Loop on Tests button starts a repetitive execution of the test or tests that
you select in the Sequence Display list box. You can only access the Loop on
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Test button from the Developer and Technician levels. When you select Loop
on Tests, the dialog box shown in Figure 3-3 appears.

=] Loop Test I

[T Stopif test FAILs

] i Cancel |

Figure 3-3. Loop Test Dialog Box

You can set the number of times the test(s) execute and also set the loop to
stop if the test fails. To set the number of iterations, enter the number of
iterations you want in the Loop control. Figure 3-3 shows a loop that will
iterate five times. If you want looping to stop when the test fails, place a
checkmark in the Stop if test Fails checkbox.

Stop If Test FAILs
When you select Stop if test FAILS in the Loop Test Dialog box, sequence
execution stops when any test fails. You can use the Stop if test FAILS box
at any operating level.

Stop on Failure
When you select the Stop on Failure check box on the main panel of the Test
Executive, the execution of test sequences stops immediately when a test fails.

Clear Test Status
The Clear Test Status button clears the Test Status/Result field for each test in
the Sequence display. You can access the Clear Test Status button in all
operating levels.

Indicators

This section describes the displays and indicators that appear on the Test
Executive front panel.

Sequence Description

The Sequence Description indicator displays the first line of the sequence
description, if available, above the Sequence Display.
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Sequence File

The Sequence File indicator located above the Test Executive Display shows
the name of the test sequence file that you have loaded.

Login Level

The Login Level indicator appears to the right of the Sequence File indicator
and shows the current login level.

Sequence Display
The Sequence Display shown in Figure 3-4 displays the lists of tests for the test
sequence you have loaded.

Seguence Dizplay:

944 Configure Fal
DC Dielectric Stren

=

Figure 3-4. Sequence Display List Box

You see a checkmark column on the left side of the sequence display. The
checkmarks you place in the column determine which test run when you click
on Run Tests or Loop on Tests. Checkmarks do not affect the action of the
Test UUT or Single Pass buttons.

Each display line, such as the ones shown in Figure 3-4, contains several
columns, with names, status codes, and icon to tell you characteristics of each
test. From left to right, the columns are the checkmark field, and the indicators
for subsequence, breakpoint, run mode, Test Name, and Test Status/Result.

The subsequence indicator displays a folder icon for subsequences.

The breakpoint indicator is blank when there is no breakpoint on the test or B
when a breakpoint is present.
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The run mode field indicates the setting of the run mode parameter for the test.
The following table shows the available run mode values and their meanings.

Table 3-1. Run Mode Fields

Value Meaning
Blank (no symbol) The test runs normally.
S The test is skipped.
P Test is skipped with a forced PASS result
F Test is skipped with a forced FAIL result

The Test Name field shows the name of the test.

The Test Status/Result field displays the word Running during test execution to
indicate the active test. After the test completes, the field displays the result of
the test. The following table shows the possible Test Status/Result field values
and their meanings.

Table 3-2. Test Status/Result Fields

Value Meaning
Pass Test result satisfied limit specification.
Fail Test result did not satisfy limit specification.
Skip Test did not execute.

Test data was logged but no comparison was made

None . e

because the limit specification was set to Log only.
Running The Test Executive is running the test.
Error Run-time error occurred during test execution.

Test Display

The Test Display shows the result of each test as it executes as well as certain
error messages. Figure 3-5 shows the Test Display.
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K

Figure 3-5. Test Display
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Result of Each Test

After a test executes, the Test Display shows the complete result of that test. A
test result takes the following form.

Test Name Result

Comment (Comment may have multiple lines and is an optional field)
Measurement Comparison Lower Limit Upper Limit

Notice that the number of lines that comprise the test result can vary, depending
on the type of comparison made and whether or not a given test logs a
comment. A test result always contains at least one line listing the name and
result of the test. The Result information is the same as the information that
appears in the Test Status/Result information is the same as the information that
appears in the Test Status/Result field of the Sequence Display.

The specific test that logs a comment determines format and content of the
Comment line(s). The Measurement field shows the measured value that the
test returned. Comparison shows the type of limit checking that determined
whether the test passed. The Condition for Test to Pass column in the following

table shows the lower and upper limit values that determine whether a test
passes or fails. The possible values of Comparison and their relation to the
Lower Limit and Upper Limit (Condition for Test to Pass) appear in

Table 3-3.
Table 3-3. Comparison Type Values
Comparison Type Value Condition for Test to Pass
Equal to EQ Measurement = Lower Limit
Not equal to NE Measurement != Lower Limit
Greater than GT Measurement > Lower Limit
Less Than LT Measurement < Lower Limit
Greater than or equal to GE Measurement >= Lower Limit
Less than or equal to LE Measurement <= Lower Limit
Greater than--Less than GTILT Measurement > Lower Limit and < Upper Limit
Greater than or equal to--Less GELE Measurement >= Lower Limit and <= Upper Limit
than or equal to
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Error Messages

When the Test Executive detects a run-time error, it displays a description of
the error in the Test Display.

Status

The Status indicator, directly below the Test Display, shows the current
operating status of the Test Executive. An LED calls attention to the Status
indicator during a testing session. The possible values of the Status indicator
and their meanings appear in Table 3-4.

Table 3-4. Status Indicator Values

Value Meaning
Stopped No test sequence is currently running.
Running Test sequence is running.
Paused Execution is paused at a breakpoint.
Looping Test sequence is looping on a test or set of tests.

Operator Dialog Boxes

During operation of the Test Executive, several dialog boxes appear that require
user action. This section describes these dialog boxes and the actions they
require.

Login

The login dialog box prompts the operator for Login Name and Password.
Figure 3-6 shows the login dialog box.
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5] C¥I Test Executive Login

FPazzword:

Cancel |

Figure 3-6. Login Dialog Box

Type the appropriate Password to set the desired operating level. Table 1-2 in
Chapter 1, Introduction, lists the default passwords. The login dialog box
appears when the operator launches the Test Executive and when the operator
selects the Login menu item from the File menu. Click on the OK button to
confirm the entries you make in the Name and Password controls. Click on the
Cancel button to remove the dialog box without making any changes to the
existing name and password. If you click on Cancel in the Login dialog box
when the Test Executive first starts running the Test Executive starts at Operator
level.

UUT Information

The UUT information dialog box prompts you to enter a serial number for the
device to be tested on the next execution of the test sequence.
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ES UUT Information X]

Enter UUT Serial Nurmber:;

e —

Figure 3-7. UUT Information Dialog Box

The UUT Information dialog box appears only when you use the Test UUT
button. You can assign any ASCII string as the serial number for a test. That
ASCII string will appear in the report for that test. You can click on the triangle
button shown in Figure 3-7 to review or select previous serial numbers. Click
on the OK button to confirm the serial number. Click on Stop to stop UUT
testing,

Pass, Fail, and Abort Banners

The Pass, Fail, and Abort banners indicate whether the current UUT passed or
failed. The Pass, Fail or Abort banner appears at the end of test sequence
execution for each UUT tested. These banners appear only when you are using
the Test UUT button. Press <Enter> or click OK to acknowledge the banner
and continue testing.

Figure 3-8. Pass Banner for Test Sequences
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This chapter describes the controls and indicators of the Sequence Editor where
you create and edit test sequences.

Vitrek Test Functions
Vitrek Test Functions are shown in Appendix A.

Using the Sequence Editor
You use the Sequence Editor of the Test Executive to create a test sequence
containing your tests. In the Sequence Editor, you can configure the run options
and test preconditions that control the flow of your test sequence. You also
specify the name of the test function and the file where it exists.

To create or modify a test sequence using the Sequence Editor, you must log in
at the Developer level. The Operating Levels section of Chapter 1,
Introduction, describes the login levels. Next you select Edit Sequences...
from the Sequence menu. Figure 4-1 shows the Sequence Editor dialog box.
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Figure 4-1. Sequence Editor Dialog Box

Test Sequence Overview
Keep the following points in mind as you create test sequences using the
Sequence Editor. A test sequence is a collection of data that describes the flow
of test execution. The main component of a test sequence is a test. A testis a
single execution step in the testing process. A test executes a function or
subsequence to perform the required testing operation. A typical test sequence
has a list of test, setup/cleanup functions, preconditions for flow control based
on Pass/Fail results, test report file information, description of the sequence, and
database information.

The tests that comprise a test sequence contain a combination of specifications
that tell the Test Executive how to perform a single execution step in the testing
process. A test specifies the following types of information:

Name of the test as it appears in the Test list of the Sequence Editor
Function or subsequence to execute

Input Buffer that contains data for test function

Limit Specification to define when a test passes or fails

Run options specifying how a test will execute

Fail and Pass actions (and maximum loop count, if applicable)
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The load mode of a test
Database and report behavior

Controls for Editing Tests
When you edit a new or existing test in the Sequence Editor, the test attributes
area appears directly below the Test list box, as shown in Figure 4-2. These
attribute controls include Test Name, Function Name, File Name, Select File,
Limit Specification, Set Limits, Input Buffer, Description, Preconditions, Run
Options, Setup/Cleanup, and Advanced. You use these controls for all
operations related to creating or modifying a test, including adding, modifying,
copying, and deleting a test.

Basic Operations for Test Editing

This section describes how to add, modify, copy, and delete tests in the
Sequence Editor.

Adding a Test

Perform the following steps to add a new test to a sequence:

1.

Modifying a Test

In the Test list box, click on the test that is above or below the position
where you want to insert the new test.

Click on New Test or New Subseq. The new, empty test appears in
the Test list box.

Enter or select the desired values for Test Name, Function Name, File
Name, Limit Specification, Input Buffer, Run Options, and
Setup/Cleanup. The Test Executive updates the Test list box as you
make changes.

Perform the following steps to modify a test.

1.

Copying a Test

Click on the test you want to edit in the Test list box. The name of the
test you selected now appears in the Test Name control of the Test
Attributes area.

Enter or select the desired values for Test Name, Function Name, Input
Buffer, Run Options, and Setup/Cleanup.

To copy a test and insert it into a new position, perform the following steps:

1.
2.
3.

Click on the test you want to copy in the Test list box.

Click on the Copy button or select Copy from the Edit menu.

Slide the Insert Position switch to Above or Below depending on where
you want the test to appear in the list.
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4. In the Test list box, click on the test that is adjacent to (above or below)
the place you want to paste the copied test.
5. Click on the Paste button or select Paste from the Edit menu. The

copied test appears above or below the test you selected in the list,
depending on how you set the Insert Position switch.

Deleting a Test
To delete a test, perform the following steps:
1. Click on the test you want do delete from the test list box.
2. Click on the Cut button or select Cut from the Edit menu. The
selected test disappears.

Sequence Editor Controls and Indicators

This section describes the controls and indicators of the Sequence Editor.

Cut

The Cut button copies the test highlighted in the Test list box to the clipboard
and deletes the test from the test sequence. You can also select Cut from the
Edit menu.

Copy

The Copy button copies the test highlighted in the Test list box to the clipboard
but does not delete the test from the test sequence. You can also select Copy
from the Edit menu.

Paste
The Paste button pastes the test in the clipboard into the Test list box. The
value of Insert Position determines whether the test appears above or below
the currently selected test in the Test list box. You can also select Paste from
the Edit menu.

New Test

The New Test button inserts a new, empty test. The test is inserted above or
below the currently selected test depending on the value of Insert Position.
Figure 4-2 shows the test attributes area of the Sequence Editor. This area is a
child panel within the larger panel that is the Sequence Editor. See the
Test/Subsequence Attributes section later in this chapter for more information
about editing tests.
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Figure 4-2. Test Attributes Area

New Subseq

The New Subseq button inserts a new, empty subsequence. The subsequence
appears above or below the currently selected test, depending on the value of
Insert Position. Figure 4-3 shows the subsequence attributes area of the
Sequence Editor dialog box. This area is a child panel within the larger panel
that is the Sequence Editor. See the Test/Subsequence Attributes section in
this chapter for more information about editing subsequences.
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Test Mame:! .
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Figure 4-3. Subsequence Attributes Area

New Goto

The New Goto inserts a new empty Goto. The goto appears above or below
the currently selected test depending on the value of Insert Position. Figure 4-
4 shows the goto attributes area of the Sequence Editor. This area is a child
panel within the larger panel that is the Sequence Editor.

Goto Target;
|ﬂ Preconditions. ..

Figure 4-4. Goto Attributes Area

Goto Target
Type the name of the test you want in the Goto Target control. To see a list of
the tests currently defined in the test sequence, you can click on the arrow to the
right of the Goto Target control.

Preconditions
This control invokes the precondition editor.
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Note: Like a test, goto statements can have preconditions that determine the
conditions under which they execute. You can specify these
preconditions in the Precondition Editor that appears when you click
on the Preconditions button.

Edit Paths...

The Edit Paths... button opens a dialog box where you can change all the
paths stored in the sequence. This helps you update the paths when the
sequence changes. Figure 4-5 shows the Edit Paths dialog box.
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Figure 4-5. Edit Paths Dialog Box

Current Paths in Sequence
This list box shows all the unique pathnames currently in the sequence. To
update a path, you can click on a test name in this list box. Then click on
Update Selected File. A dialog box appears where you can choose an
updated path for the file.

Update Selected File...
This button opens a file dialog box where you can specify a new path.

Pathnames after Changes
This list box displays the pathnames the Test Executive uses; it is only an
indicator. A checkmark appears to the right of the name(s) when using the
Update Selected File... button to update a pathname.

Database

The Database... button opens a dialog box where you can get options for
saving test results to a database. Figure 4-6 shows the Database Options
dialog box.
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Figure 4-6. Database Options Dialog Box

Enable Saving Results to Database
This check box enables database operations for the Sequence.

Connection String (Data Source)
Enter the connection string or use the Set button to select from a list of available
data source names.

Database
This field identifies the default database for database systems that allow you to
store tables in separate databases. In most cases, you do not need to use the
Database field.

Sequence Results
Controls in this area determine how the Test Executive saves sequence results in

the database.

Table Name specifies the database table that stores sequence results.
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Test Results

The checkboxes under Saved Columns allow you to choose the information to
save for each sequence result. The UUT Number and Sequence Result are
always saved. You can also save the Date, Operator, Sequence Name, and
Run Order. When you save results from different sequence files in the same
table, you may want to save the Sequence Name, too, to make it easier to
identify the origin of each result.

Controls in this area determine how the Test Executive saves individual test
results in the database.

The Enable checkbox enables saving of test results to a database table.
Table Name specifies the database table used to store test results.

The Log checkboxes allow you to select whether Fail results, Pass results, and
Skip results are saved to the test results table.

The checkboxes under Saved Columns allow you to choose the information
that the Test Executive saves for each test result. The Run Order, UUT
Number, Test Name and test Result are always saved. You can also save the
Measurement, Limit Specification, Output Buffer, Error Flag, Error Code, Error
Message, and Sequence Name.

Create Tables

OK

Note:

Cancel

The Test Executive automatically creates the database tables as needed. You
can use the Create Tables button to force the immediate creation of the tables.

The OK button saves any changes you make to the test sequence, including
preconditions, and returns you to the Test Executive front panel.

The Test Executive saves changes to any database options when you
save the sequence file.

The Cancel button discards any changes you make to the test sequence and
returns you to the Sequence Editor.
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Test Attributes Area
You use the controls in the Test Attributes area to set the attributes of individual
test in the test sequence. You also use the controls in this area to set attributes
of subsequences. This area is a child panel within the larger panel that is the
Sequence Editor. Figure 4-7 shows the Test Attributes area.

Funchan Mame:

Diescriptior. . |
| Cnfg |
File: tdame: Preconditions. .. |
C:4itrek 344 gpib. obj | Select File... |
.. e Fun Optionz... |
Limit Specification;
{BOOL} Set Limits... | Test Parameters | SetupdCleanup... |
|nput Buffer;
10,1,0,0.0,0.0,0 | bdvanced |

Figure 4-7. Test Attributes Area

Test Name

Type any ASCII string in the Test Name control. The name appears in the
Sequence Display of he Test Executive front panel when the sequence is
loaded. Each test must have a unique name.

Test Parameters

Test Parameters checks the test function name and pops-up a parameter panel
if a Vitrek test function is found. Each pop-up panel has a series of parameters.
Individual parameters may be selected or defaults restored by pressing
Restore Default Parameters. Press Save Parameters and Exit when
selection is complete. The new parameters will appear in the Input Buffer for
that test.

Function Name

Type the name of the test function in the Function Name control.

Note: Subsequences have no function names.

File Name

Type the full path name of the file that contains the test into this field. You can
also click on Select File... to open the File dialog box where you can locate
and select the file name.
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Limit specification
The Limit Specification specifies the type of limit checking the Test Executive
uses to determine if a test passes. You cannot type directly into the Limit
Specification field. To specify a limit, click on the Set Limits... button. Use
the Comparison Type ring control to set the comparison type and the
measurement. Figure 4-8 shows the Set Limits for Test dialog box.
(=] Set Limits for Test I

Comparizon type:

2 Bo0L

Mo comparizon done by Test Executive - Test
zetz statuz flag to indicate PASSFAIL state.

[+ Test fall causes sequence fail

Figure 4-8. Set Limit for Test Dialog Box

Comparison Type ring control specifies the type of comparison to perform, if
any, to determine whether a test passed. Table 3-3, Comparison Type Values,
in Chapter 3, Operating the Test Executive, describes the values for each
comparison type.

For some comparison type settings, one-limit or two-limit entry controls appear
in the Set Limits for Test dialog box. A one-limit value appears for the
comparison types EQ, NE, GT, LT, GE, and LE. As shown in Figure 4-9, two
limit values, a lower and upper limit, appear for the comparison types GTLT,
GELE, GELT, and GTLE. No limits appear for the comparison types BOOL,
LOG, and NONE.

Note: Subsequences can use only the comparison types BOOL, LOG, and
NONE.
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Figure 4-9. Comparison Type Settings

Input Buffer

As shown in Figure 4-7, the Input Buffer control displays a string that is passed
into a test function. The content and meaning of the string are determined by the
test function. The test functions used by QuickTest are 8 character
configuration file names. Enter the desired input string into the Input Buffer
control.

Note: Subsequences have no input buffers.

Description

The Description button shown in Figure 4-7, invokes the Precondition Editor,
See the Editing Preconditions section in this chapter for more information on the
Precondition Editor.

Preconditions

The Preconditions button, shown in Figure 4-7, invokes the Precondition
Editor. See the Editing Preconditions section in this chapter for more
information on the Preconditions Editor.

Run Options

The Run Options button, shown in Figure 4-7, opens the Test Run Options
dialog box where you can specify the Run Mode, Fail Action, Pass Action and
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the maximum number of loops for a test. Figure 4-10 shows the Test Run
Options dialog box.
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Figure 4-10. Test Run Options Dialog Box

Run Mode
Run mode specifies how the test executes. Table 4-3 describes the options for
Run Mode.
Table 4-3. Run Mode Options
Run ModeValue Meaning
Normal Execute Tests normally.
Skip Do not examine the test; set result to SKIP
Force Pass Do not execute the test; set result to PASS .
Force Fail Do not execute the test; set result to FATL.
Fail Action

Fail Action specifies an action to take when the test fails. Table 4-4 describes
the options for Fail Action.

Table 4-4. Fail Action Options

Fail Action Meaning
Next Test Continue execution with next test.
Loop Repeat execution of the test.




Chapter 4 Creating Test Sequences

Stop

Stop Execution of the test.
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Pass Action
Pass Action specifies an action to take when the test passes. Table 4-5
describes the options for Pass Action.

Table 4-5. Pass Action Options

Pass Action Meaning
Next Test Continue execution with next test.
Loop Repeat Execution of the test.

Stop Stop execution of the sequence.
Running The Test Executive is running the test.

Max. Loops
The Max. Loops control appears only when Fail Action or Pass Action is set to
Loop. This control specifies the maximum number of loop operations to
perform when, for example, the Fail Action is set to Loop, and the test fails.

Setup/Cleanup

The Setup/Cleanup button, shown in Figure 4-7, invokes the Test
Setup/Cleanup Routines dialog box for an individual test. Figure 4-11 shows
the Test Setup/Cleanup Routines dialog box.

5] Test Setup/Cleanup Routines

Setups/Cleanup

Function Hame File Mame Input Buffer

Setup | SelectFie | I

| Cleanup - Select File |
i

Figure 4-11. Test Setup/Cleanup Routines Dialog Box

Setup Function

A setup function executes before a test. You enter the name of the setup
function in the Function Name control. You enter the name of the file that
contains the function in the File Name control, or click on the Select File button
to open the File dialog box, where you can select the file you want. If you leave
the Setup-Function Name control blank, no setup function runs. See the
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Writing Test Functions section of this chapter for information about writing your
setup functions.

Cleanup Function

A cleanup function executes after a test. Enter the name of the cleanup function
in the Function Name control. Enter the name of the file that contains the
function in the File Name control, or click on the Select File button to open the
File dialog box., where you can select the file you want. If you leave the
Cleanup-Function Name control blank, no cleanup function runs. See the
Writing Test Functions section of this chapter information about writing you
cleanup function.

Advanced

The Advanced button, shown in figure 4-7, invokes the Advanced
Test/Subsequence Attributes dialog box for an individual test or subsequence.
Figure 4-12 shows this dialog box.

[ Advanced Test/Subsequence Attributes

Load Mode :-I Pre-load Test

™ Suppress Reporting for Test

™ Suppress Database for Test

Load Mode

Figure 4-12. Advanced Test/Subsequence Attributes Dialog Box

Load Mode specifies the load mode for an individual test. The load mode can
be either Pre-Load Test or Dynamic Load Test. To make these values take
effect, you muss set the

Load Mode ring control for sequences (which is located in the Sequence
Attributes area of the Sequence Editor dialog box) to Use Test Load Specs.
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Supress Reporting for Test
When selected, Suppress Reporting for Test prevents the Test Executive from
saving any report information in the report file regarding the test you are

modifying.

Suppress Database for Test
When selected Suppress Database for Test prevents the Test Executive from
writing test result information to the database regarding the test you are

modifying.

Subsequence report
Subsequence Report sets the report behavior within a subsequence. While a
subsequence executes, it can use one of the following command options from
this ring control:
Use Parent’s Report Options
Use Subsequence’s Report Options
Suppress Reporting within Subsequence

Subsequence Database
Subsequence Database allows you to select the database behavior of a
subsequence. While a subsequence executes, it can use one of the following
command options from this ring control:
Use Parent’s Database Options
Use Subsequence’s Database Options
Suppress Database within Subsequence

Sequence Attributes
The controls in the Sequence Attributes are used to specify the load mode
description, setup/cleanup functions, and report file for the test sequence. You
can see all these controls in the Sequence Editor dialog box shown in figure 4-1.

Load Mode

Load Mode controls how the sequence is loaded. You can select one of the
following items in the Load Mode ring control.

PreLoad Test—All tests and subsequences are loaded when the sequence is
loaded.

Dynamic Load Tests—Tests and subsequences are loaded and unloaded as
needed.

Use Test Load Specs—The load specification of each test determines whether
it is loaded when the sequence is loaded or loaded only as needed.
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Description

The Description button displays a dialog box where you can enter and modify
the description of the test sequence. Figure 4-13 shows this dialog bot
sequence designation appears in the Test Report that the Test Executive
generates when it executes a test sequence. The first line of the description also
appears in the Description field on the Test Executive front panel.

] Test Sequence Description

Orly first line of description appears on operator panel.

Config., DC Dielectric _-:j

(] Cancel

Figure 4-13. Test Sequence Description Dialog Box

Setup/Cleanup
The Setup/Cleanup button, shown in Figure 4- 1, opens the Sequence
Setup/Cleanup Routines dialog box. There are two types of setup/cleanup
functions available. Sequence Execution functions run at the beginning and at
the end of each sequence execution. Sequence load/unload functions run when
the sequence is loaded or unloaded. Figure 4-14 shows the Sequence
Setup/Cleanup Routines dialog box.
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Figure 4-14. Sequence Setup/Cleanup Routines Dialog Box

Report...

The Report... button, shown in figure 4-1, displays a dialog box where you set
the attributes of you Test Report. Figure 4-15 shows the Set Default report
File dialog box. You type the name the report file you want to create in the
Test Report file control or click on the Select File... button to open the File
dialog box, where you can select the name of the report. When you set Report
File Mode to Append, the Test Executive adds your report to the end of an
existing report. Choose Overwrite to replace the existing report file. Select
Lock File Name to prevent users from changing the name of the report file.

(=] Set Default Report File !

Tezst Repart File:

C:AWirekWac Dielectric Strength.rpt : Select File... 1

Report File Mode:

Append I¥" Lock File Mame
Owenarite

Figure 4-15. Set Default Report File Dialog Box

Editing Preconditions
The preconditions of a test specify what other tests must pass or fail before that
particular test executes. To define the preconditions of a test, click on the
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Preconditions button, shown in Figure 4- 1, in the Test Attributes dialog box of
the Sequence Editor. Figure 4-16 shows the Precondition Editor.
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Figure 4-16. Precondition Editor

The name of each test in the test sequence appears in the Tests list box. One of
the test names in the Tests list box is always highlighted. The Preconditions list
box shows the preconditions test—those test on which test execution depend—
for whichever test name you select in the Tests list box. In Figure 4-16, Power
On test and ROM test are the preconditions for ROM Diagnostics. ROM
Diagnostics run only when Power On test passes and ROM test fails.

Take the following steps to specify the preconditions for a test:

In the Tests list box click on the test for which you want to set preconditions.
All the preconditions you set will apply in the test you have selected.

If you want to apply multiple preconditions, establish grouping for the
preconditions by clicking on the appropriate button:

a. Click on Add All Of to insert ALL OF: in the Preconditions list box.
This type of heading introduces a series of preconditions that must all be true in
order for the test to run.

Click on Add Any Of to insert ANY OF: in the Preconditions list box. This
type of heading introduces a series of preconditions of which at least one must
be true.

You can nest ALL OF: and ANY OF: headings, to create more complex
preconditions.
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Click on Add Condition... The Add Condition dialog box shown in Figure 4-
17 appears.

=] Add Condition I
Tests: T
vpe:
.......... 944 Confimg el oo rEe palL
< =

Figure 4-17. Add Condition Dialog Box

In the Add Condition dialog box, set the Type switch to PASS or FAIL...
depending on whether you want the precondition test(s) to pass or fail.

Select the precondition test(s) from the list. A checkmark appears beside the
test and a P (pass) or an F (fail) also appears depending on whether you have
set the Type switch to PASS or F.

Click on OK to confirm your setting and return to the Sequence Editor dialog
box.

The following list describes all the controls in the Precondition Editor dialog box:
The Insert Position switch determines whether new preconditions are inserted
before or after the current precondition.

The Add All Of button inserts ALL OF: to begin a block of preconditions
which must all be true.

The Add Any Of button inserts ANY OF: to begin a block of preconditions of
which at least one must be true.

The Add Condition. .. button invokes the Add Condition dialog box.

The Tests list box shows the available precondition tests. The setting of the
Type switch (pass or fail) determines whether the precondition test(s) you select
must pass or fail.

The Move to the Left and Move to the Right buttons, shown in Figure 4-18,
adjust the level of the currently selected preconditions. In general, Add
Condition set the level properly, so you should seldom have need of the Move
to the left and Move to the right buttons.
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Figure 4-18. Move to the Left Button and Move to the Right Button

The Delete Condition button deletes the selected precondition.

The Clear Conditions button clears all the preconditions for the test selected in
the Tests list box.

The OK button saves any changes you make to the test sequence preconditions
and returns you to the Sequence Editor. Changes you make to preconditions
take effect only when you click on the OK button in the Sequence Editor. The
Test Executive saves all preconditions with the test sequence when you select
Save from the File menu on the Test Executive Front panel to save the test
sequence to disk.

The Cancel Edits button discards any changes you make to the test sequence
preconditions and returns you to the Sequence Editor.

Effect of Preconditions and Run Mode on Test Flow

The preconditions and run mode for each test determine the test executive flow
for a test sequence. The Test Executive performs the following steps to
determine whether or not to execute a given test:

The Test Executive evaluates the preconditions for the test. For a test to
execute, the result of each precondition test must match the result specified in
the preconditions. If evaluation of preconditions indicates that the current test
should be skipped, the test result is set to SKIP.

The Test Executive checks the run mode of the test. If the run mode is Normal,
the test executes. If run mode is set to any value except Normal, the test does
not execute. Table 4-6 shows the value that each run mode generates for a

skipped test.
Table 4-6. Run Mode Test Result Values
Run Mode Value Generated
Normal Test success determines value.
Skip (Test not run) SKIP

Force PASS (Test not PASS
A

Force FAIL (Test not
run)

FATL
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When the Test Executive evaluates preconditions, it does not distinguish
between a real PASS/FAIL result, where the test actually executed and a

forced PASS/FAIL result.
Appendix A — Vitrek Parameter Panels

|§ Cnfg Parameters

GFIE Address H\. Beep Ao Response Auto-ground
210 | & | &n | Fom
R amp Do Saf Sne |R-mil

Ell .o =l |

Rezet Farms to Default | Save Parms and Exit

Cnfg Parameter Panel

|§ La_ohm Parameters

bl ax Resiztance in Resistance Test Time
=i - T | 2w | a0

Rezet Farms to Default | Save Parmz and E it |

Lo_ohm Parameter Panel

|§ Lo_ohm_930 Parameters

GPIE Address Test Current Frequency bl ax Resziztance
210 =AY - | Z0am
Min Resistance Test Time

= L |

Rezet Farms to Default | Save Parms and Exit

Lo _ohm 930 Parameter Panel
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|§ keg_ohm Parameters

ﬁ'l[l.l:l |

Bezet Parms ta Default |

GPIB &ddress Test “oltage Slew Fate in Resistance
= = 1] =TT | 200E+E
Test Time

Save Parmsz and Exit |

Meg ohm Parameter Panel

==—=====---Vac Paameless

GPIE Address Test Yoltage Slew Rate Frequency

2o E= T R iy | 4 |
Current Sense P ax Current Min Current Test Time
TOTAL  w|  %q000E3 | S000E«D | F100 |

Bezet Parms to Default |

Save Parmz and Exit |

Vac Parameter Panel

|E=——————————=V/dc Parametess

GPIB &ddress Test VWoltage Slew A ate bl & Dl Current

210 | 21000 | 2m | 2i000E3 |

kdir Current b ax Ramp Curent Test Time Farp Current Hold Time
2000E+0 | SM000EE | A100 ={1i |

Rezet Farms to Default |

Save Parmsz and Exit |

Vdc Parameter Panel

E==—————=-V940 Parameless

H B H BN BN EEEEBN
m o5 08 13 17 21 258 29 33 3IF 41 45 GPIB Address
ENENEE R R R 10
02 06 10 14 18 22 26 30 34 38 42 46 ﬂ—l
I_ I_ I_ I_ I_ I_ I_ I_ I_ I_ I_ I_ Beset Parms to Default |
03 o0fF 11 15 19 23 27 3 3/ 39 43 47
I_ I_ I_ I_ I_ I_ I_ I_ I_ I_ I_ I_ Save Parmsz and Exit |
04 08 12 16 20 24 28 32 36 40 44 48

WL W_HIGH

V948 Parameter Panel
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FH 944i RESULTS MESSAGE

"WARMING: IMTERLOCES OFEMED DURIMG TEST COMTACT
SUPERVISIOR.

V944i Results Message Parameter Panel

V4 RS-232 Parameter Panel

From Present Step

V4 Utility Configuration Parameter Panel
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V4 DCW Parameter Panel

il 5] ¥4 ACW Test Parameters

EEE -
T 0

V4 ACW Parameter Panel

V4 IRS Parameter Panel
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5

V4 GBON Parameter Panel
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